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CS205 COURSE SYLLABUS- Sutio1t a01tly 
Computer Literacy and Office Automation 

fll\,Structor: KLVVt c;ros 
kgros@hcst.net 

361-8077 or 879-5812 

COURSE OBJECTIVES: 

• 	 To understand basic computer operations and the principal components of a computer and 
connected peripheral devices 

• 	 To understand and examine current operating systems, software utilities, device drivers and 
application software 

• 	 To define and understand current storage technology and learn about logical file storage and 
management 

• 	 To become proficient in using application software categories that are covered in the seven 
modules 

• 	 To understand the basiCs of e-mail 
• 	 To introduce networking concepts including the Internet and its components and web browser 

basics 
• 	 To learn ways to protect your data and avoid computer disasters 

The course is divided into 7 modules and may be presented in the following order: 

1) Computer Concepts 

2) Introduction to the Internet including e-mail and newsgroups 

3) Introduction to Windows 

4) Spreadsheets 

5) Database 

6) Word Processing . 

7) Presentation Graphics Software 


The following software is used in the 320 Oleman lab: 

- Microsoft Windows XP 

Microsoft Office 2003 

Internet Explorer 


REQUIRED TEXTS: 

Computer Concepts 5rd Edition by June Jamrich Parsons and Dan Oja 
Microsoft Office 2003 Introductory Concepts and Techniques by Shelly, Cashman and Vermaat 

Note: You are responsiblefor purchasing the books and bringing them with you to 
class. Booksfor loan are not available in the classroom and lab. 

MATERLt\LS NEEDED: 

2 blank high density diskettes (1.44 :MB) 

1 diskette carrying case - optional 
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COURSE EVALUATION: 

Each module includes assignments to check your understanding of the presented material. The 
assignments each have an assigned due date and the assignments should be turned in at the beginning of 
that class (before lecture starts) in order to receive full credit. Late assignments will not be given full 
credit. .. no exceptions. All assignments should be turned in - even if it is already late. Please collect 
and keep all graded assignments for your records. 

There are four examinations covering the concepts and applications of each module. The exams are a 
combination of written and "hands-on". 

Exams MUST be taken at the scheduled times. If for emergency reasons, you are unable to take 
an exam on the scheduled date, CONTACT ME PRIOR TO THE EXAM or AS SOON AS POSSIBLE. 
You have my home and mobile numbers, I should hear from you before the next class. Be prepared 
to provide supporting documentation. 

Grade Weights: 
Lab. Assignments 100 pts. * 
Examinations 220 * You must complete a minimum of 60% of 
Attendance 40 the assignments for each module to pass 
Unannounced Quizzes ~ the course. 

400 pts. 

There will be 15 points of extra credit available during the quarter and we will use the following grade 
scale. 

90-IOO=A 80-89=B 70-79=C 60-69=D 

DISABILITY SERVICES: 

Students with special needs should make the Instructor aware of any requirements needed to complete 
CS205 during the FIRST WEEK OF CLASS. 

320 Oelman OPEN LAB HOURS: 

You will not finish your assignments during class time and may use the lab during the listed open lab times 
or visit the labs in the library annex or l 52C Russ Eng building. 

Monday & Wednesday 12:30 1:30 PM 

Sunday 2:00-4:00PM 


SAVING DATA: 

All data generated by applications in 320 Oelman must be saved to your local diskette drive (drive A). 
You should save often - do not wait until you are :finished (there is always a risk of something going 
wrong with the computer). Data saved to the local hard drive may not be recoverable after you log out. 

BACKUP POLICY: 


You are responsible for maintaining a backllp copy ofyour assignments. 
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LABORATORY POLICIES FOR 320 Oelman 

1) 	 Do not modify or add files to the hard disk on the personal computers. 

2) 	 You are responsible for doing your own work. You are not to make copies of files for others or accept 
others files. Academic misconduct procedures wili be followed. Refer to the following web site for a 
listing of the Academic Integrity Guidelines. http://www.wright.edu/students/judic.iaJJstu integrity.html 

3) 	 Refer to the following web site for a complete listing ofResponsible Use oflnformation Technology 
Guidelines for the rules on Internet use at the university. 
http://www.wright.edu/students/handbook/03 22.html 

4) 	 Label all diskettes (and books) with YOUR NAME and SECTION NUNIBER. 

5) 	 Do not use the computers during the lecture, unless instructed to do so by the instructor. YOU 
SHOULD NOT BE WORKING ON HOMEWORK DURING LECTURE. 

6) 	 You are responsible for saving your work to your personal 3.5'', 1.44:MB diskette, not to the C drive (hard 
drive) on the computers. Ifyou save your files to the C drive, they may be deleted when the cleaning 
program is run. 

7) 	 The printers are to be used for CS205 assignments only. Do not print an assignment or any other 
document unless instructed to do so by your instructor. For CS205 printed assignments print 1 copy 
only - check the print preview first. 

8) 	 Watch where you put your feet and hands. The computers are connected to the network and outlets by 
cables that can become unplugged if moved. Do not move the computers or printers. 

9) 	 When finished working on your PC, shut it down. Please be sure to tum off both the monitor and the 
processing unit. 

10) No eating, smoking or chewing gum at any time near the computers. Drinks with twist lids are allowed. 

11) Making unauthorized copies of the software is prohibited. 

12) Notify the instructor or proctor of any hardware malfunction. 

USING THE HP LASER.JET 4 PRINTERS 

Do NOT attempt to correct problems yourself, including paper out or paper jam problems. Do NOT 

print during lectures. 


CS205 WAIVER APPLICATION 

Ifyou feel that you are already proficient in the material covered in CS205, you may apply to waive this 

class (based on the requirements of your college). Please check with your advisor. You may pickup a 

CS205 waiver application form in 303 Russ Center. Note that ifyou do choose to apply for a waiver, 

you must remain enrolled in the class while the waiver is processed. If the waiver is approved, you must 

then formally drop the class. With a waiver, you do not receive credit for the course. 


CS205 PROFICIENCY EXAM 

Students taking the CS20 5 Proficiency Exam will potentially earn credit for the course ( 4 credit hours) IF 

you pass all sections of the exam with an average >= 80% for each section. Ifyou are interested, please 

check with your advisor or see the instructor for more information. 


COMPUTER SCIENCE/COMPUTER ENGINEERING MAJORS 

CS205 may not be applied towards Computer Science or Computer Engineering degree requirements. 
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XXX HOMEWORK ASSIGNMENTS: XXX 
Follow all the directions and steps carefully (from the syllabus and book)!!! 


This is simply a summary - Look at the following pages for detailed instructions. 


This table is to help you organize your assignments and grades. Keep this for your records. 

Assignment Date Due Grade 

Concepts Assignment 1 Handouts 12 

Concepts Assignment 2 Fill in from page 67 14 

Concepts Assignment 3 Fill in from page 101 14 

Concepts Assignment 4 Fill in from page 3 1 14 

Concepts Assignment 5 Fill in from page 173 and 16 
Intemet/E-Mail from syllabus 

Windows Module Assignment 1 From syllabus 15 

Test #1 /55 

Excel Assignment 1 In the lab 1 pg EX 58 15 

Excel Assignment 2 In the lab 1 pg EX 132 /10 

Excel Assignment 3 In the lab 1 pg EX 212 /10 

Excel Extra Credit Case & Places 1 pg 222 15 

Test #2 (Excel) /55 

Access Assignment 1 In the lab 1 pg AC 56 15 

Access Assignment 2 In the lab 1 pg AC 109 /10 

Access Assignment 3 In the lab 1 pg AC 168 15 

Access Assignment 4 Case 1 pg AC63, AC112, AC171 /10 

Extra Credit (Excel & Access) From syllabus /10 

Test #3 (Access) /55 

Word Assignment From syllabus /15 

PowerPoint Assignment From syllabus 15 

Test #4 (Word & PowerPoint) 155 
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Computer Concepts Module - Printed and Online 

Procedure for Answering Questions: 

For these questions you are required to supply \Vritten answers. Use a word processing software, such as Notepad. 

Word.Pad or Word, to record the answers to the questions. The first items typed in the file should be your name, 

the assignment number and the section number. Do not worry about formatting the document. Save and print 

the document and tum it into the INBOX at the front ofthe room. 


Assignment 1: Read: Office 2003 Book-Intro to Computers-Pages COM2- COM18 
Do: MC and Fill In questions These are available already printed in class or follow the 

instructions on page COM 39 #1 to print the questions from the internet. 

Assignment 2: Read: Computer Concepts Book - Unit B 
Do: Fill in the Best Answer on page 67 - There is a typo on #7 It should read 

"CD-RW technology .... " 
You do not need to repeat the questions on your printout- simply give me the word(s) that you 

need to fill in the blank. 

Assignment 3: Read: Computer Concepts Book - Unit C 

Do: Fill in the Best Answer on page 10l 


Assignment 4: Read: Computer Concepts Book - Unit A 

Do: Fill in the Best Answer on page 3 I 


Assignment 5: Read: Computer Concepts Book - Unit E 
Do: FilI in the Best Answer on page I 73 and the following Internet portion 

Note: To do this assignment on campus, you must obtain your Wright State student account from Computing 
and Telecommunications Services. All WSU students are assigned accounts. You will need to pick up the 
account information at the CATS help desk in the basement of the Library AnneL (Room 025) - bring a 
picture ID. 

The mail reader used here on campus is http://webmail.wright.edu 

Look through web sites to find a computer system you would personally want to purchase. Some 
popular manufacturers that you are likely to find on the web are Dell, Gateway, IBM and 
Apple or web sites for stores like BestBuy, CompUSA or Target. You are not limited to 
these vendors. E-mail me the web page (or the link) that shows the information about the 
computer you selected. Send the e-mail to kgros@hcst.net and in the body of the e-mail 
include your full name and a paragraph describing the reasons you selected that machine. 

8/28/2004 Syllabus for Section 08 only Page 5 

mailto:kgros@hcst.net
http:http://webmail.wright.edu


Windows Module - Printed 

Read: 	 Computer Concepts Book - Unit D 

Microsoft Office - Introduction to Windows pages WIN4 WIN67 


Part A: 
In the Concepts book page 134, look at the file organization options in Question 1 of Independent Challenge 3. Consider 

the file organizing methods given in options a g and choose the method that you like best. Write a paragraph on the 
advantages and disadvantages of that method. 

Part B: 

Type in the definitions, instructions or step by step procedures for each of the following. 


1) What is an active and inactive window 
2) What is a path of a given file - include an example 
3) How do you show file properties 
4) What are the different views in Windows Explorer 
5) How does a file become fragmented 
6) What does a file that has an exe or com extension do 
7) Define the tenns Byte, KB, MB, GB 
8) Define the terms root, subdirectory and file 
9) How do you do a proper shutdown of Windows 
10) How do you change a file name 
11) How do you erase files 
12) How to select a series of adjacent files from a list 
13) How to select a series of non-adjacent files from a list 
14) How to move and/or copy files from a drive/folder to another 
15) How to maximize, minimize and restore a window 
16) How to Fonnat a disk 
17) Find (or search) for a specific file 

Procedure for Printing Future Assignments: 
All :future printouts must have a required "header" and "footer". The header must have your name and the assignment 

number. The footer must have your section number and the current date. This required information can be positioned 
anywhere across the top and bottom of the page. 

Note: Ifyou complete the homework assignments outside of the CS205 lab, the files must be in a format readable by 
Office 2003. You are responsible for presenting the files in a readable format if needed! 

Spreadsheet Module - Printed 

*Assignments will not be accepted without "formula printout"* 
.Make sure that the whole formula is showing. Points will be taken offifwe can not see the whole formula. 

Excel Assignment 1: Read: Microsoft Office - Excel Project 1 

Do: In The Lab 1, page EX 58-59 


Use the following clarifications for the specified steps prO\ided in the book. 

Skip step 6. 

During step 7, put the information requested into cells Al l:Al5 instead of the cells given in the book. 
Skip step 9 
Before you print in step 11, add the required header and footer. Then print, display your formulas and print again 
(this time in landscape and on one page). 
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Excel Assignment 2: Read: Microsoft Office - Excel Project 2 
Do: In The Lab l, page EX 132 - 133 

Use the following clarifications for the specified steps provided in the book. 
In step 3, use the sum function. 
In step 6, ifyou do not have the font style "Broadway" then switch to something similar. Also, change the 
background color to red for Al :I2. 
In step 10, make sure you have the required header and footer and make sure it prints on one page. 
In step 11, print the formulas, in landscape, on one page. 
After you are done with the steps in the book, create a 3-D pie chart using the Employee Names and their Net Pay. 
Include a title, no legend, and with category name and percentage showing. Create the chart as a new sheet. Once it 
is finished, increase the title font size to 24, bold the labels, explode the largest pie piece and elevate the chart to 50. 
Add the required header and footer before printing. Turn in the three printouts. 

Excel Assignment 3: Read: Microsoft Office - Excel Project 3 
Do: In The Lab 1, page EX 212-214 (Part 1 and 2 only) 

Use the following clarifications for the specified steps provided in the book 
In step 4, make columns B :H the width of 11.57 
In step 5, format the assumptions so that they look the same as shown. 
In step 7, be sure to use the "Absolute Reference Rule of Thumb" that we discussed in class. Try to create your O\.Vn 
formulas using the "math equation in words" given and do not look at the actual formula with cell references that is 
also given. 

- Before you print in step 10, add the required header and footer. 
Skip step 11 
In Part 2, include the required header and footer then print the chart only. 
After you finish Part 2, go back to the spreadsheet and use the goal seek to determine a margin (cell B24) that would 
result in a net income in 2010 of $1,000,000. Print the chart again and on that printout hand write the new margin 
that the goal seek computed. Tum in the four printouts. 

Excel Extra Credit 
Do: Cases and Places 1, page EX 222 

There are few specific requirements for this assignment. You still need the required header and footer. With the 
information given in the case, calculate the requested information. You will have two sets of assumptions (% of 
output for each candy and price for each pound). You should use absolute references where needed. 

Format the worksheet to look professional and print on one page. Display the formulas and print again (in landscape and 
on one page). Print the chart with the required header and footer. 

Database Module Printed 

**Access does not convert well to other versions of the program. 
Keep that in mind if you are not using Office 2003** 

Access Assignment 1: Read: Microsoft Office Access Project 1 
Do: In The Lab 1, page AC 56 - 58 

Use the following clarifications for the specified steps provided in the book. 
Skip steps 4 and 7. 
During step 10, ·when you create the report, include you full name in the title of the saved report. Print the report 
from Access. (it will not have the required header and footer) 
When you are finished with the steps in the book do the following steps so that you can print the table contents from 
Excel: (Ifyou are familiar with Word, you may print your tables from that program rather then Excel). 

11) Open tl1e Item table in datasheet view. Highlight all ofthe records. Copy the records into the "clipboard 
memory". Click on the Start button and open Microsoft Excel. In a new document make the file landscape and 
insert your required header and footer. Go under the Edit Menu to the "Paste Special" command. Choose the 
option for te).'1. 
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12) 	On the task bar at the bottom of the screen, click on the Microsoft Access button. Open the Supplier table in 

datasheet view. Highlight all of the records. Copy the records into the "clipboard memory". 


13) 	On the task bar at the bottom of the screen, click on the Microsoft Excel button. Move your cursor to a blank row 
(maybe leave a blank row between your tables). Go back to the Edit Menu and the Paste Special command. 
Choose te:ll.'t. In order to display all of the texi in the cells- highlight the columns used (or choose select all) and 
under the Format Menu go to "Column" then "Autofit Selection". Print the document from Excel with both tables 
(in landscape) and on one page. 

14) 	 Tum in both printouts. 

Access Assignment 2: Read: Microsoft Office Access Project 2 
Do: In the Lab 1, page AC 109 - 110 (Continuation ofAssignment 1) 

DO NOT PRINT EACH STEP!! 
Use the following clarifications for the specified steps provided in the book. 

For each step, where it says to print, you should "SA VE AS" the query onto your disk. Use the step number from the 
book to individualize the queries. Create all queries in Design View. 
Skip steps 5, 8 and 10. (You should have 10 queries when :finished.) 
When you are all finished, run each query and copy to Excel (or Word) as explained in Assignment 1. You should be 
able to fit the results of all the queries on 2-3 pages. Print these pages in either landscape or portrait. 

Access Assignment 3: Read: Microsoft Office - Access Project 3 
Do: In The Lab 1, page AC 168 (Continuation ofAssignment 2) 

You will need a file from the data disk that came with the book. Ifyou do not have the disk, ask us for the file. Use the 
following clarifications for the specified steps provided in the book. 
In step 3, you should click on the browse button to find your Birds2U file from assignment 2. 
Skip step 7. 
In step 8, do not print 
Skip steps 12-14 
Print the contents ofboth tables as described in Assignment 1. 

Access Assignment 4: 
Do: Cases and Places 1, page AC 63, AC 112 and A3.58 
In the first chapter, create the tables as e:ll.J>lained in the book. You will have one table for the clients and another 
table about the walkers and they will have a field in common (Walker Number). You will get the data for the tables 
from a file on your student disk. Ifyou do not have the student disk,, ask us for the file. After you have all of the data 
entered you will print the tables using the same instructions given in Assignment 1 and using the required header 
and footer. 
In the second chapter, create and save the queries given. Print tlie results of these queries as you did in assignment 2. 
In the third chapter, do steps a - c only. During step (c), put in the default value and validation rule requested. Also 
put in validation text. Print the table about the customers only - using the same instruction in Assignment 1 with 
header and footer. On your printout record EXECTLY what you typed in as the default value, validation rule and 
validation texi. 
Tum in all of these printouts together. 
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Excel and Access Extra Credit-Printed 

Excel Portion 


Do: In the Lab 3 page EX 218 (Part 1 Only) 

There is a typo in step 2, Insert the two new columns between columns F and G 

After Step 17, sort rows 4-10 by employee name 

Skip step 19 

Before you print in Step 20, double check your header and footer. Save the file again. 

When you print the formulas in step 21, you will need to make sure to adjust the column widths so that the entire 

formula is displayed. 

Turn in the two printouts and continue with the Access portion. 


Access Portion 
Copy the data from rows 4-10 from the Excel spreadsheet and using "Paste Special" put the values in one of the 

blank "sheets" of that same file. Save and close the spreadsheet. 

Open up :Microsoft Access and create a blank database called Illiana Custom Homes. Create a new table and use the 

"Import Table" option. In the Import dialog box, change the file type to Excel and find the file you just saved. 

Choose Import. You will need to pick the sheet that you saved your data on and then continue the \Vizard to create 

the table in Access. 

Go to Design View then change any fields data type and properties that are needed in order to match the data that 

you have in the table. 

Create and save two queries that use at least one criteria each and are sorted in some way. Create and save another 

query that creates a total (sum or average). 

E-mail me your access file. 


Word Processing Module Printed 

Word Assignment: Read: 	Microsoft Office - Word Project 1 and 2 

Computer Concepts Unit F 


Choose a topic from the Computer Concepts Unit F and create a research paper using the Concepts book as one 
reference and a web site as a second reference. This paper should be at least one full page (double spaced). 
Create the research paper according to the MLA documentation style described in the second Word chapter for 
margins, line spacing, font size, work cited page, header... (there are several examples shown in that chapter). 
The MLA requires a specific header at the right margin and you should also include my required header and footer. 
After the last paragraph of text, before the work cited page, insert a table containing a list of application software 
categories and their use (example: word processing, spreadsheets ....). Use a heading row in the table with llie 
headings of "Category" and "Software Use". The table should then be formatted to Classic 1 style and single spaced. 
Put your two references on the Work Cited page, format and sort the references. After your last reference, on a blank 
line, insert a clipart of a computer and size it to 2 5% of its original size. 
Your finished product will be on multiple pages. Print the paper. 
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Presentation Graphics Module - On Disk 

Read: M.icrosoft Office - PowerPoint Project 1and2 

Using the topic covered in your Word paper, create a presentation that is at least 5 slides in length. 
Use whichever template design you want. 
You must use each of the following four slide layouts (at least one time each) then you can use any other layouts you 
wish: Title Slide, Bulleted List, 2 Column Text and Text & Clip Art 
On the Title Slide, include your name and the section number as the sub-title. The section number should be a 
smaller font then your name. Bold and Italicize your name. 
Be sure to save the :file to your disk often so that you do not loss your information. 
On at least your 2 column text slide, you must use at least three levels of bullets. 
On one slide, double space at least one paragraph. 
On all of the slide, change the first level bullet to a picture of a disk (from the Wingdings Font). 
On all of the slides, change the Title Font color to a shade of green. 
Choose one slide and change the background color to something other then what it was originally. 
Include a header/footer on all slides that contains the date, your name, and the slide number. 
Relocate your title slide to the end of the presentation. 
Add an appropriate clipart to your Text & Clipart slide. 
Choose one transition style and apply it to all of the slides. 
On your 2 Column Te:x.'i slide, apply a build effect (custom animation) that is grouped by TIIB 1 •t level bullets. 
Apply to both columns of text. 
Spell check your presentation. 
This assignment is NOT printed. When you are all finished, tum in your disk for grading. Make sure your name 
and the file name are written on the label of the disk. 
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